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1 Introduction

1.1 Purpose

The DLT Viewer tool can decode, view and store DLT messages generated by the DLT Daemon. The
DLT Viewer tool enables the software developer and the tester of the device to view and control the
log and trace information. It is not the goal of GENIVI to provide full functional analyzing tools for
traces, but to provide a basic set of utilities to visualize, control and test all features of the DLT
Daemon component in a simple way. The DLT Daemon component and the DLT Viewer are based
on the AUTOSAR 4.0 standard DLT.
We try to keep the GUI simple for an e�ective and e�cient work�ow, but also to integrate as much
functionality as needed.

1.2 Restrictions and limitations

The DLT Viewer once was created as an example application how to receive and display messages
delivered by a DLT Daemon running on a Linux DUT ( device under test ). Do not regard it as a
perfect reference implementation. The only existing requirement when starting the DLT Viewer
development was "we need something like a DLT Viewer". So depending on the used hardware (
RAM and hard disk size ), the amount of messages send by the daemon and the amount of connected
devices or the pure size of a log�le limits performance.

1.3 Feature List

• Graphical User Interface

� Menu and toolbar

� Project widget

� DLT Message Table

� Search results widget

� Footer with information about the current �le etc.

• View DLT �les

� Drag and Drop support

� Recent �les selection

� Temporary �les support

� Append �les

� Index cache of already opened DLT �les

� Default DLT �le loading

� Open multiple �les (v2.10.1)

• Retrieve DLT messages from targets and store them in DLT �les

� Serial connections

� TCP/IP connections

� Multiple parallel connections

� Autoconnect to targets

� Con�gure log levels and trace status

� Store con�guration in target

� Reset the target's con�guration

� Organise connections in projects

• Filter DLT messsages for analysing
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� Support to show only a de�ned subset of the messages

� Complex �lter con�gurations

� Save and restore �lter con�gurations

� Multiple default �lter con�gurations

� Markers to highlight speci�c messages

� Filter index cache of already �ltered DLT �les

� Regular expressions

� Sorting by receive time (starting with v2.10.1)

• Clipboard support

� Copy selected DLT messages to clipboard

• Export of DLT �les in multiple formats

� Supported formats:

∗ DLT format with selection

∗ ASCII format

∗ CSV format

� Select the messages to be exported

∗ All messages

∗ Filtered messages

∗ Marked messages

• Search DLT messages

� Step by step search

� Search export view

� Search by regular expressions

• Project con�gurations

� Control log levels

� Organise con�gurations in projects

� Save and restore projects

� Recent projects selection

� Select displayed columns

� Default project loading

� Automatic timezone synchronisation (v2.10.1)

• Plugin con�gurations

� Decoder plugins to decode messages

� Viewer plugins to show more detailed information and analyse logs. Viewer plugins
provide extra widgets to visualize data

� Control plugins to control applications on the target

� Available plugins

∗ DLT Viewer Plugin

∗ Non Verbose Mode Plugin

∗ Filetransfer Plugin

∗ DLT Logstorage Con�g Creator Plugin ( outdated )
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∗ DLT System Viewer Plugin ( outdated )

∗ DLT DBus plugin

• Command line support

� Silent mode

� Loading project

� Loading DLT �le

� Using �lter con�guration

� Export DLT �les to ASCII

� Execute commands in plugins

• Plugins programming guide
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2 DLT Viewer GUI

2.1 Layout

The screenshot in ?? will give you a quick impression about how the Viewer could look. The Viewer
is based on Qt, so there are widgets you can move around and resize as you like. Your settings of
position and size of the widgets are stored when you close the Viewer so that you have exactly the
same window when you launch the Viewer the next time. To get a better understanding about the
DLT Viewer parts the screenshot below marks the relevant areas followed by a description.

Figure 1: Main DLT Window sections
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Table 1: GUI section description

Nr Title Description

Menu and Tool-
bar

In the window title you can �nd the absolute path of your project
�le and the project name. If you start the DLT Viewer with no
default project �le it will create an unnamed project.
The menu consists of:

• File Open and save �les, access DLT Viewer settings etc.

• Search Search for speci�c messages in the current log.

• Project Create, open and save DLT Viewer projects.

• Con�g Add, edit and remove ECUs, applications and con-
texts.

• DLT Additional functions concerning the DLT daemon and
the current con�guration.

• Filter Create, open and save �lters for the message log.

• Plugin Enable, show and edit plugins.

• View Select the visible components of the DLT Viewer.

• Help Get information and help for the DLT Viewer. Find
here detailed version information, the support email address
as well as an overview of the comandline options.

The menu provides main functions to the user. Many menu func-
tions are also easily accessible through the toolbar. Hover the
cursor over toolbar buttons to see their functions.

Project Panel

The project widget allows you to con�gure and control the project,
load an existing project, save a changed con�guration to the DLT
Daemon and more. The project panel is split into three tabs:

• The "Con�g" tab, which contains all connected ECUs/De-
vices. Each Device contains its connected applications. Each
application contains its used contexts.

• The "Filter" tab lets you con�gure �lters and markers, which
are used to show or mark only a de�ned subset of DLT mes-
sages in the message table.

• The "Plugin" tab shows the available DLT Viewer plugins.
The development team provides a plugin SDK to you. You
are able to write your own DLT Viewer plugins to decode
messages, display an extra GUI panel or control the Viewer
and target applications.

In the settings you can e.g. select a default project, which is loaded
during start-up.
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DLT Message Ta-
ble

In the DLT Message Table you see all DLT messages in the current
DLT log �le. Newly received DLT messages are written to the end
of the log �le. If the AutoScroll option is enabled in the settings,
the table will scroll along with new DLT messages while they are
received. The columns in the message table are:

• Index Index of the DLT message in the DLT log �le.

• Time Time when the message was received.

• Timestamp Time when the message was sent, measured
since the startup of the target.

• Count Cyclical counter, one per context. Can be used to
detect lost messages.

• Ecuid Name of the sending ECU. De�ned in the "Projects"
tab.

• Apid Indeti�er of the message sender application. De�ned
by the sending application.

• Ctid Context indenti�er of the message sender. De�ned by
the sending application.

• Sessionid Process ID of the target process / application
submitting the message.

• Type Type of the message (Log / Trace).

• Subtype Log level or trace type.

• Mode Verbose or Non-Verbose.

• Args The number of arguments in the payload of the mes-
sage.

• Payload The payload shows all parameters of the log mes-
sage as text.

If a �lter is con�gured, you will see only DLT messages which
match this �lter. Remove or disable all �lters if you want to see all
messages. If there are decoder plugins and a DLT message matches
one of these plugins, the decoded payload is displayed instead of
the raw payload. DLT log �les can be loaded and saved in the �le
menu.

Plugin Widget
Provides one or more widgets to display additional data. You can
choose which plugins are to be shown in the "Plugin" tab. See
section ?? and chapter ?? for more information.

Footer
The footer shows information about the current log �le, the version
string ( see ?? ) and other options of the DLT Viewer.

Search table
The search table shows all resulting lines of a search pattern as
well as the amount of search hits
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2.2 Project Panel

2.2.1 Con�g Tab

Figure 2: Con�g Tab

In the con�g tab you can see a hierarchical list of all con�gured devices, applications and contexts.
The ECU item lists the ID of the ECU, its status (red = o�ine, yellow = connecting,green = online),
a description of the ECU including the connection interface, the defaultlog level and the default trace
status.
The application item lists the ID and the description of the application.
The context item lists the ID, the description, the log level and the trace status of the context.
Double clicking an item lets you con�gure it. Right clicking an item gets you a context menu,
depending on the type of the item:

Right click on empty space to add a new ECU connection

See ?? on how to connect to an ECU.

Right click on an ECU ( ECU Edit ) to change or con�gure ECU settings
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Right click on an application to con�gure an application

Right click on a context to con�gure a context

2.2.2 Filter Tab

The �lter list gives you an overview of all con�gured �lters. Only DLT messages which match the
enabled �lters are displayed in the message table view. Double clicking a �lter item lets you change
the �lter. Each �lter can be customized to include or exclude messages, to check for speci�c ECUs,
applications or contexts, for header and payload content and more. It is also possible to create
marker �lters, which don't include or exclude any messages but highlight them in a selected color.

Figure 3: Filter Tab

By right clicking ( or select Menu bar → Filter ) you get the following menu to add or change a �lter:

"Save Filter" lets you store your �lter con�guration to a �le with extension *.dlf. Both the "Load
Filter" and the "Append Filter" option will load a saved �lter �le, but "Load Filter" will reset your
current �lter list while appending keeps it.
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The �lters you set will apply to all incoming or loaded DLT messages. If you also want to apply the
�lters to previously logged messages, hit the "Apply Con�guration" button on the top of the "Filter"
tab.
Seel also ?? for more information on how working with �lters.

2.2.2.1 Filter Quickselect

You can use the quick select bar to choose and enable your favourite �lters placed in the default �lter
path. The �lters can be selected from the drop down list. If you place a new �lter there, it will be
recognized at start up or after pressing "Refresh". To set the default �lter path see also ?? Viewer
Con�guration Settings .

Figure 4: Filter quickselect

2.2.3 Plugin Tab

The plugin list shows all loaded plugins. Plugins e.g. can be used to:

• decode DLT messages

• provide additional graphical widgets

• control the viewer

• send injection messages to target applications

• control any attached measurement equipement like USB or IEC devices

Double clicking on a plugin item creates a popup window which lets you enable/disable the plugin
and select a con�guration �le for it. On more informnation for the plugins see chapter ??.

Figure 5: Plugin Tab
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• The "Name" column shows the name of each plugin. This name is provided by the plugin itself.

• The "Status" column shows which plugins are enabled and visible. Only plugins that
implement the "View" interface can have the status "Visible".

• The "File" column tells you the path of the con�guration �le or �les for plugins that have such
a �le or �les selected. Double click on plugin items to choose con�guration �les for them.
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2.3 Viewer Con�guration Settings

Access via "File → Settings Menu".
Set general behaviour of the viewer like temp �le locations.

2.3.1 Global Settings

Here the "�le behaviour" like e.g. locations and usage of log �les or index �les can be con�gured.

Figure 6: Global Settings Tab

Here �nd some selected descriptions:

1. Temporary File Behaviour

In "Temporary File Behaviour" you can set some parameters concerning the temporary �le
which is always created during live tracing. You can just use the system default location or
de�ne a custom folder of your choice.

CAUTION: Keep in mind that in case "Save temporary �le on clear" is selected
the amount of �les in your tmp path increases and your hard disk will easily
run out of space. So take care about this temp path !

2. Default log File
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If enabled, the given log �le will always be opened instead of creating a new tmp �le at Viewer
startup. Live tracing messages are appended to this �le. The changes to this setting take place
the next time the viewer is started. In case the �le does not exist it is created.

CAUTION: In case you do not remove/change the log�le e.g. in an automated
setup, it may easily increase and cause the viewer to take a long time loading
the �le at next start !

3. Default Project

If enabled, the given project �le will always be opened at viewer startup. The settings in the
project �le rules the default viewer con�guration settings. The changes to this setting take
place the next time the viewer is started. On project �les see ??.

4. Plugins Path

If enabled the viewer will look for plugins in this location additionaly to the default locations.
See also ??.

5. Plugins Autoload

If the plugins autoload path is enabled and set accordingly you can make use of the plugin
autoload feature.
On details how to use plugins autoload see ??

6. Default Filter Path

If the default �lter path is enabled and set accordingly you can use the "Filter quick select bar"
in the Filter Tab. Also see ?? Filter Quickselect .

7. Index Cache

When the index cache is enabled, reloading of previous loaded �les is much faster because the
index is cached in additional �les. To reduce disk space consumption these �les can be
automatically deleted after the speci�ed amount of days of last access. The deleting takes place
the next time the viewer is started. The index �les have the extension "*.dix" and are located
in the speci�ed folder.

CAUTION: If this option is enabled, additional disk space is used. Take care
to observe the size of the index �le directory, especially in case you perform
frequent comandline conversions e.g. in an automated setup. So it is recom-
mended to disable index caching for commandline usage.

8. Performance Settings

When "Start up Minimized" is enabled the viewer window is not shown diretly. Most propably
makes sense when using logging only mode.

The Refresh Frequency speci�es the amount of viewer GUI refreshes per second.
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2.3.2 Project Table Settings

Figure 7: Project Table Tab

1. Table font size

Here you can set the desired font size to be used in the message table view, the default font size
is 8.

2. Select columns to show in the viewer

In the this settings tab you mainly can select which columns you want to have displayed in the
table view. See also ?? on information about the columns.

3. Show Arguments

This setting may be only interesting for dlt application developers. The column "Args" shows
the number of payload arguments contained in the DLT message.

The check box "Show Argument Columns" is not functional.

4. Show Application

Select if the Apid shall be shown, if so you can choose the Apid itself or the description string
which comes with the application registration message.

5. Show Context

Select if the Ctid shall be shown, if so you can choose the Ctid itself or the description string
which comes with the context registration message.
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6. Show Session/Process Id

Process ID of the target process submitting the message. "Session Name" only is available if
transmited by the daemon.

7. Set time column automatic to local recording time

Here you can choose which time for the receive time column should be used. You can just take
local time of the system or use the DLT time settings by choosing the time zone and the mode
of daylight saving time.

2.3.3 Project Other Settings

General logging behaviour con�gurations

Figure 8: Project Other tab

Some choosen settings:

1. Auto connect to ECUs at start

If this chechbox is enabled the last ECU connected is tried to be connected automatically. In
case you are using a project �le this setting may be overruled !

2. Auto scroll

3. Auto mark fatal/error messages

Automatically mark all messages of subtype ( loglevel ) "fatal" and "error" with red color.
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Note: in case you use a �lter using a marker the �lter overcolor rules this setting.

4. Auto mark warn messages Automatically mark all messages of subtype ( loglevel ) "warn" with
yellow color.

Note: in case you use a �lter using a marker, the �lter color overrules this setting.

5. Auto mark marker messages

Automatically mark all marker messages with green color.

Note: in case you use a �lter using a marker, the �lter color overrules this setting.

Example:

6. Write Control Messages to Log File When this checkbox is enabled, control messages like
register or unregister of applications or contexts, SW version and get_log_info from the
daemon are displayed in the message table and stored in the log�le.

7. Update Contexts when loading Log �le

The list of contexts is updated automatically when a log �le is loaded.

8. Update Contexts Unregister

The list of contexts is updated automatically when a context is deleted.

9. Logging only mode When enabling this check box you activate the "logging only" mode, see ??:

10. Append Date/Time to �lename when closing DLT Viewer

The time when the DLT Viewer is closed is appended to the current log�le name. Of course
this implies that you did save the temprorary log �le to a custom �le before as the tmp �le
usually is not saved ... Here also the log �le �les gets a name appendix of type

__YYYYMMDD_hhmmss____YYYYMMDD_hhmmss

11. Maximum File Size

The log�le is split up in several �les of given maximum size in [MB]. The �les get a name
appendix of type

__YYYYMMDD_hhmmss____YYYYMMDD_hhmmss

and the end receive time stamp of the log. So later you can also concatenate the �les to a single
one in the right order.

E.g.:

cat *.dlt >> combine.dlt

CAUTION: Depending on the message tra�c and the choosen split �le size
there may occur a message loss in case the split �le size is to small ( < 10 kb )

12. Manual marker color

Select your favourite color for marking selected lines in the table view. Right mouse click on the
table view to highlight the selected lines. Marking only has a visual e�ect, there will be no
additional information stored in a �le. The coloring refers to the line index, not to the message
index. In case you change the order of the messages e.g. by �ltering or loading another log�le,
the highlighting will remain on this line index anyway. To completely remove the highlighting
again also use "File clear".
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2.3.4 Viewer Con�guration File

The basic viewer con�guration �le is "con�g.ini". It e.g. stores the Viewer Settings, plugin states as
well as size and windows position. Its default location is:

~/.dlt/config ( on Linux )

and

C:\Users\<username>\.dlt\config ( on Windows )

This �le is not overwritten in case you reinstall the Viewer. In case you install a new release of the
viewer it may be better to delete the �le to avoid inconsistency. A new instance of the �le containing
default values will be created when the viewer starts.
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3 Plugins

The feature set of the DLT Viewer can be easily extended with DLT Viewer plugins. Plugins have
full read access to trace messages. They can decode messages, provide additional representations
inside the DLT Viewer GUI, control the Viewer or send injection messages to target applications,
depending on which DLT interfaces the respective plugin implements. It is easy to write your own
DLT Viewer plugin, examples are provided in the DLT Viewer source code.
Here is an overview of the some useful plugins:

3.1 Non Verbose Mode Plugin

Interface:

• QDLTPluginInterface

• QDLTPluginDecoderInterface

Description: Decodes the DLT non-verbose messages after a catalog �le has been loaded.
If you receive DLT messages in non verbose mode, you need to decode them to see their plain text.
To do this, go to the "Plugin" tab in the "Project" panel. Double click on the plugin "Non Verbose
Mode Plugin". In the dialog that appears, you can open a con�guration �le to load. Use this to load
a non verbose XML description �le, which corresponds to your software on the ECU. Hit "OK" and
the Plugin shows a list of all available non verbose messages. As soon as you select a DLT message
you can view the decoded information. Incoming messages that �t the description �le will now get
decoded. To also decode the already received messages, hit "Apply Con�guration" on the top of the
"Plugin" tab. This plugin has no visible widget.

Raw nonverbose messages example:

Decoded nonverbose messages example:

3.1.1 DLT Parser

To create an input �le for this plugin based on your target DLT Daemon con�guration in nonverbose
mode, have a look on the tool "DLT Parser". Also see the DLT Daemon documentation on the non
verbose mode.
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Figure 9: DLT Parser

3.2 DLT Viewer Plugin

Interface:

• QDLTPluginInterface

• QDLTPluginViewerInterface

Description: Advanced visual representation for selected log messages.

Figure 10: DLT Viewer Plugin widget

3.3 DLT DBus Plugin

Interface:

• QDLTPluginInterface

• QDLTPluginViewerInterface

• QDLTPluginControlInterface

• QDLTPluginDecoderInterface

Description:

Decode and show DBus messages.

This is an example of raw DBus messages in the table view:
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This is how it looks like when the messages are decoded:

In the plugin widget you get more detailed information about the DBus message. And a more
structured depiction in the Header tab.

Figure 11: DLT DBus Plugin widget

Figure 12: DLT DBus Plugin widget, Header tab

DBUS messages are identi�ed by a special combination of Apid/Ctid: the default is DBUS/ALL in
case you do not load a special con�guration �le.
Example: in case you need to use the two combinations of Apid/Ctid:
DBSY/DBSY
DBCN/DBCN
To enable these two combinations use the delivered example �le

"dbusplugin_configuration.xml"

which is located in the plugins/examples folder (Windows) or /usr/share/doc/genivi-dlt-viewer
(Ubuntu) of your viewer installation. If the Apid/Ctids changes you can edit the �le and change or
add items for your need. The total amount of Apid/Ctid combinations is limited to 10 due to
performance reasons.
The con�guration �le is loaded e.g. in the plugin con�guration widget:
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Figure 13: DLT DBus Plugin con�guration widget

3.4 Filetransfer Plugin

Interface:

• QDLTPluginInterface

• QDLTPluginViewerInterface

• QDLTPluginControlInterface

Description: In case your log contains �les like screenshots, coredumps etc. logged by a DLT
Filetransfer application the objects can be viewed and saved with this plugin.

Figure 14: File transfer widget

By double clicking the �le name, you can see the �le contents as preview and a text or image viewer
is opened.
After enabling the �letransfer plugin when a dlt �le already was loaded you will have to reload the
log�le !
You can also use the Filetransfer Plugin command line mode to extract �les out of a stored dlt �le
e.g. in an automated test setup. On more information about the command line mode see ??.

3.5 Plugin SDK

More information about the Plugin SDK can be found in the seperate document
dlt_viewer_plugins_programming_guide.pdf. In the source code you also �nd four dummy plugins,
ready to build. You can just use it as a template.
There are

• dummycontrolplugin
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• dummyviewerplugin

• dummycommandplugin

• dummydecoderplugin

3.6 Using the plugins autoload feature

For the nonverbose mode or the DBus plugin, the used con�guration �le may e.g. depend on the SW
version of your target. In case the DLT Daemon is con�gured to send out the target software version
instead of the DLT Daemon version ( see DLT Daemon documentation ) you can automatically load
the according con�guration �le needed by the plugin.
This is especially helpful if you work with traces of di�erent ECUs or software versions.
See also ?? for information about the version string.
To use the autolaod feature you need to create a subdirectory whichs name equals exactly the name
of the choosen plugin, e.g. "DLT DBus Plugin". In this directory you can place plugin con�guration
�les whichs names exactly equal the version string send by your target. So if you process logs with
di�erent target software versions the correct con�guration is automatically loaded accordingly.

3.6.1 Plugin autoload example

1. E.g. the version string is "Aspire_SW123":

2. Create a directory named "E:\viewertests\DLT DBus Plugin" and place a con�guration �le
namend "Aspire_SW123.xml", ( or so named folder which contains this �le ) there.

3. Set the plugins autoload path accordingly to "E:\viewertests" and set the checkbox, see ??

4. Enable the plugin itself and load the dlt �le or connect to the target

5. The con�guration �le is automatically processed as soon as the version string is received:

3.7 Install, remove, enable and disable plugins

3.7.1 Windows

The DLT Viewer will look for plugins in two places. The �rst place is the "plugins" folder inside the
main application path. After that, if a plugins path is de�ned in the DLT Viewer settings ( see ?? ),
the application will also look in this speci�ed location for plugins.
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You can install plugins by putting them into one of the directories mentioned, and uninstall them by
removing them from these directories.
It also is possible to enable or disable plugins in the DLT Viewer itself. To do this, double-click or
right-click on a plugin in the "Plugins" tab. You will get a drop-down menu for enabling and
disabling the plugin. When enabled, messages are passed to the plugin. When disabled, the plugin
will be ignored in the message processing chain. For plugins that implement the "viewer" interface,
there is also a third selection, "Enable and Show", which brings up the UI widget of this plugin.

3.7.2 Linux

On Linux, organizing plugins works in a similar fashion. In addition to the previously mentioned
folders, the Linux version will also look into "/usr/share/dlt-Viewer/plugins" for any plugins. You
will need to have root permissions to modify the plugin directories that are installed system-wide. To
organize plugins without root permissions, you can set the user de�ned plugin directory in the DLT
Viewer settings to some other path, e.g. somewhere in your home directory.

4 Best Practices

4.1 Connect to ECU

Press the connect button to connect to the target:

If no ECU is con�gured, the ECU con�guration dialog appears. Select the "Interface Type" you want
to use (TCP, UDP or serial). The ECU con�guration dialog also can be envoked by selecting right
mouse button "ECU add" in the Project Con�g Panel.

24



Figure 15: ECU dialog

Here you can set some basic parameters like

• Id
Identi�er of the "Electronic Control Unit" used in the con�g tab. If it is left at its default value
(ECU1) it will automatically be set by the ECU messages which come with the connection.

• Description
Description of the ECU Id used in the con�g tab

• Interface Type
You can choose TCP, UDP or Serial

• Default Log Level ( equals "Subtype" in the message table ), see also ??

• Default Trace Status ( on / o� )

• Verbose Mode ( yes / no )
See also ??

• Timing packets from ECU
Request the ECU to send additional timing messages ( see daemon documentation )

• Send "Get Log Info" if online
See ??

• Send "Get SW Version" if online
Request SW version from daemon, see also ??
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• Send "Default Log Level,Trace Status and Verbose Mode" if online

• Update data in DLT if online
Send the above selected request to the ECU always when connecting to it

4.1.1 TCP

If you choose a TCP connection enter the the hostname or the IP address.
Format is e.g.192.168.0.5 of the target ECU.
In case of an IPv6 address just use the format ( e.g. ) fe80::xxxx:xxxx:xxxx:%eth1
IPv4 example:

Figure 16: IP con�guration tab

4.1.2 UDP

In case of UDP reception you are able to specify the interface and the IP port where you expect the
UDP datagrams to be received. The selection box "Receiving interface" will o�er you all available
ethernet interfaces of your machine. In case of AnyIP the oprating system will choose an interface for
you. To receive multicast messages you can activate "Multicast on network interface" and specify the
UDP multicast address to join the multicast group accordingly.

CAUTION: On Windows machines it was observed that the selection of the speci�c
IF instead of AnyIP is essential

IPv4 example:
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Figure 17: UDP con�guration tab

4.1.3 Serial

If you choose a serial connection, select the serial port here. Check the COM port where your serial
device is connected to in your Windows con�guration. A drop down list provides a list of examples
for the port con�guration.
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Figure 18: Serial con�guration tab

If you select "OK" the DLT Viewer will try to connect to the ECU. The ECU Id shows "online"
(green) as soon as the DLT Viewer is connected to the speci�ed device. All received DLT messages
should then be displayed in DLT message table.
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4.2 Available List of Applications and Contexts

4.2.1 Hierarchy

Applications and contexts are organized in a hierarchy. Each ECU connection can have several
applications. Each application can have several contexts. Contexts are the instance where the loging
application con�gures log levels and trace status.
In the Project/Con�g tab you will see a tree with all used applications and contexts in a sub tree of
an ECU.

4.2.2 Get all used contexts from ECU

In case you are connected to the ECU you can get all used contexts by double click on the ECU item
in the Project/Con�g tab and select menu item "DLT Get log info". The DLT Viewer then sends a
request to the target and receives a response message with all available contexts and their log levels.
The list of available contexts is added to your "Con�g" list.

Figure 19: Get log info

4.2.3 Automatically update used context

There are several possibilities how to automatically update the list of contexts of a ECU.

4.2.3.1 Get context list when connected to ECU

Each time you connect to the ECU you can get a list of all used context. You can activate this
feature in the ECU con�guration by activating "Send Get Log Info if online". See ??.

4.2.3.2 ECU sends automatically new registered contexts

This feature must be activated in the DLT daemon con�guration of the ECU.
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4.3 Log levels and trace status con�guration

Each DLT log message provides a log level. The following table shows the di�erent available log
levels and describes in which use cases they should be used.

Table 2: GUI section description

Log Level Usage

DLT_LOG_FATAL
Fatal errors are errors which prevents the software to continue
working.

DLT_LOG_ERROR
Normal errors are errors which are detected by the software, but
do not prevent the software to continue working.

DLT_LOG_WARN Warnings are used when some minor problems are detected.

DLT_LOG_INFO

Info is the standard log level. It is used to display all kind of
information, so that the device tester knows that the functionality
of the software is correctly working. This log contains e.g. version
information or state change information of SW modules.

DLT_LOG_DEBUG
This log level is normally turned o�. It should be used to display
some more deep information about the functionality of a software
component.

DLT_LOG_VERBOSE
This log level is normally turned o�. This log level provides huge
amount of logs from a SW component and should only be enabled
for individual SW components.

In case the default log level is set to DLT_LOG_INFO for the ECU, all log messages from
DLT_LOG_FATAL to DLT_LOG_INFO are send out by the daemon and displayed.
DLT_LOG_DEBUG and DLT_LOG_VERBOSE messages are not generated in this use case.

4.3.1 Get default log level

Request the current default log level directly from the ECU.

4.3.2 Set ECU default log level

The default log level can be set for each ECU connection separately. Just open a current ECU
con�guration by double click on the ECU item in the Project/Con�g tab. You can change the value
of "Default Log Level" and "Default Trace Status" and press OK. If you are connected the new
default values are send to the ECU immediately. All Contexts which are set to "default" get the new
default values. The option "Update data in DLT if online" must be activated. When you connect to
the ECU the con�gured default values are send immediately. See ??.

4.3.3 Edit all log levels

Here you can edit and set the loglevels for all contexts at once. If the checkbox "Update data in DLT
if online" then the log level for all contexts is set. E.g. you can switch o� tracing for all log levels at
once. In this case the DLT daemen does not send out any messages except DLT control messages.

4.3.4 Set individual log levels

To set individual log levels and trace status for a dedicated context you can to double click on the
context item in the "Project/Con�g" tab. A Context con�guration dialog is opened where you can
set individual log level and trace status. Press Ok to send the changed log level to the ECU.
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Figure 20: Context con�guration

4.3.5 Set all con�gured log levels of all contexts

You can send all con�gured log levels, e.g. when you stored the log levels in the project �le. Right
click on a ECU item in the "Project/Con�g" tab and press the menu item "DLT Set All Log levels":

Figure 21: DLT Set all loglevels

4.3.6 Store all log levels and trace status in ECU

You can store the current con�guration of all log levels on the ECU. After restart of the ECU the
current set log levels and trace status are available again. Right click on a ECU item in the
"Project/Con�g" tab and press the menu item "Store Con�g":
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Figure 22: Store all loglevels
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4.4 The version string

Depending on the setting "ECU Software version info" in dlt.conf con�guration of the DLT Daemon
the daemon sends either the daemon version or the content of a given �le on the target periodically.
The version is transmitted by a special control message, for example:

You also can request the version string manually:
Right click on a ECU item in the "Project/Con�g" tab and press the menu item "Get software
version".
The version string is shown in the footer (see ??) of the dlt viewer. Assumend this method is used to
identify target and software version you can also use it for plugins autoload feature, see also ??.

Version string example 1 ( daemon version )

Version string example 2 ( daemon version with tooltip )

In case the version string is too long to be displayed in the footer you can see the full name in the
tooltip by hoovering above the version string.
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4.5 Working with DLT Log Files

When you start the DLT Viewer, a temporary log �le is created. The default location of these log�les
is con�gurable (see ??) in the Global Settings Tab. All received DLT messages get stored in this
temporary log �le and shown in the DLT message table. A �le containing messages usually is
associated with a target / ECU connection. In case of livetracing the messages received from all
connected ECUs are stored in the same �le.

4.5.1 Save as

Select the menu option "File"→"Save as" or to save a �le. Saving a �le just renames the current
tmp �le and stores it to the selected destination, the received messages are still added to this �le and
the �le is processed / accessed by the DLT Viewer. A saved �le also contains information about ECU
con�guration, Apids, Ctids and log levels.

CAUTION: In case you did open multiple �les to concatenate them, e.g. by
Drag&Drop then only the last opened �le will be saved. If you want to save all �les
in one please use "Export ..."

4.5.2 Export

Select the menu option "File"→"Export... ". There are several options for exporting messages:

Figure 23: Exporter dialog

1. Format: �le format of the exported messages

(a) DLT: DLT binary format, the �le can be loaded and processed by DLT Viewer.

(b) DLT Decoded: store the selection in DLT binary format, the resulting �le can be loaded
and processed by DLT Viewer. In case a decoder plugin was active, the decoded message
payload is stored in human readable way.

(c) UTF8: stores the selection as UTF8 text �le.

(d) ASCII: stores the selection as ASCII text �le.

(e) CSV: like ASCII but columns are seperated by semicolon.

2. Selection: choose which messages to be exported

(a) All: all messages in the current log�le.

(b) Filtered: only messages which apply to the active �lters.

(c) Marked: all marked lines are exported. Marked lines are either manually marked in the
table view or lines marked by a �lter. "Automarked" lines like warn/error or marker
messages are not taken into account.
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4.5.3 New �le or open �le

Select the menu option "File"→"New/Open" to create a new or open an existing log �le.

4.5.4 Import DLT Stream

Select the menu option "File"→"Import DLT Stream" to import a an existing log �le which does not
contain DLT �le storage headers. The log�le messages are imported into the currently opened dlt �le.

4.5.5 Import DLT Stream Serial

Select the menu option "File"→"Import DLT Stream" to import an exiting serial log �le. Just the
log�le messages are imported without an ECU con�guration or Apid / Ctid informations.

4.5.6 Append DLT File

Select the menu option "File"→"Append DLT File" to append the message content of the selected
�le to a current �le. The message index is automatically increased but the messages may not be in
the correct order regarding reception time stamp. This can be achieved by "Filters Enabled" with
"Sorted by Time". See ??.

4.5.7 File clear

Select "File"→"Clear" or to clear the current log �le. The message table view and the indexes as
well as the search result windows are cleared. If con�gured, a new tmp �le is automatically opened.

4.5.8 Open multiple �les

Data logging devices usually create log�les of a determined size. So for analyzing a trace you may
need to concatenate these �les to one single �le. On a Linux machine you e.g. could do that with:
"cat *.dlt � resulting.dlt"
cat *.dlt accesses the �les sorted by the �le name, that means the correct order of the �le must be
determined by the �le name.

4.5.9 Searching and navigating in the log�le

4.5.9.1 Jump to line / index

Select Menu "Search"→"Jump to" or keypress combination "STRG + G" to directly navigate to the
desired line / index number in the table view.

4.5.9.2 Quicksearch

Using the input �eld in the menu bar you can perform a quicksearch, the string entered is used a
search pattern to �nd matches in the payload of all messages as con�gured in the Search Dialog. Use
the green arrows in the menu bar to navigate in single step mode or �ll the search results
window.

4.5.9.3 Advanced search

If you want to specify more details and other search parameters you can use the Menu

"Search"→"Find" or search icon in the toolbar to open the search dialog.
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Figure 24: Search dialog

• Text to search
The search string you are looking for in the trace.

• Search from:
Search whole log or starting from the current selected line.

• Highlight color:
Select the color to highlight the hit line in single step mode.

• Find all:
If enabled then all search hits are listed in the search results window, else the search runs in
single step mode: jump to the results with Previous ( F2 ) or Next ( F3 ) or using the green
arrows in the menu bar.

• Search in Header
Search hits in the message header will be shown too. E.g. search for a certain receive or target
time stamp.

• Search in Payload
Search hits in the message payload will be displayed. This is most probably the standard
option.

• Search Options: Case Sensitive

CAUTION: If enabled the search time may increase signi�cantly !

• Search Options: Regular Expression
Use regular expression search.

• ApId
Only take care of messages with this ApId.

• CtId
Only take care of messages with this CtId.

• Timestamp start / end
All search hits will have target time stamps within the given time range will be shown.

• Payload start / end
All search hits will be in the range of a payload which contains the given start string and a
payload which contains the given stop string will be shown.
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4.5.9.4 Search history

You can use the menu "Search"→"History" to select the last used search strings. There also is a drop
- down menu in the search input �eld of the toolbar to select the last used search strings.

4.5.10 Setting a Marker

When you set a marker in the log�le using DLT → Marker, or just click on the icon: , a marker line
is added to the bottom of the current trace, this is especially meaningfull when live tracing to mark a
certain point in the log.

The marker line looks like this:

These marker messages can be automatically highlighted in green color, see in ?? in Settings /
Project Other.
But keep in mind: Marker messages are "control messages". So they are not displayed in case "Write
Control Messages to log �le" is not enabled. See ?? in Settings / Project Other.

4.5.11 Logging only mode

In case you only want to record traces for later analysis without viewing them in the DLT message
table, it is recommended to enable the "Logging only mode". All plugins and the main table view are
disabled. So you reduce performance impact and the probability of a viewer crash e.g. due to a faulty
plugin.
See ??, "Viewer Con�guration Settings/Project Other", how to enable it.
Basically you also can use the commandline tool dlt-receive to receive dlt messages and write them to
a �le. It is part of the dlt-daemon and so only is available on Linux systems.
Example:

dlt-receive -o ./logit.dlt 160.48.199.99
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4.6 Working with Filters

You can �nd some example �lters in your viewer installation directories and in the source code in
directory "�lters":

* control_messages.dlf

* error_fatal_messages.dlf

* message_buffer_overflow.dlf

* software_version.dlf

In case you de�ne �lters please take into account that message �ltering has performance impact. It is
recommended to combine sevaral search parameters in one �lter de�nition instead of cascading
multiple �lters. When searching for payload content you can improve performance if you also limit
the �lter using a certain Ctid or Apid where you expect your message in.

CAUTION: More and complex �lters slow down the viewer !

4.6.1 How to create a �lter

There are several ways to add a �lter:

1. Menu "Filter"→"Filter Add"

2. On a context or application item in the Con�g tab of the Project Panel: selecting right mouse
button "Filter Add". The avaiable Ecuid, Apid, Ctid will be �lled in already.

3. On a message in the message table view select a line and right mouse button "Filter Add". All
message elements except log levels are �lled in already.

Figure 25: Filter con�guration

1. Name: any name describing your �lter function

2. Type:
Positive ( default): all hits which match the �lter will be shown in the message table
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Negative: messages which �t the �lter will NOT be shown in the message table
Marker: messages which �t the �lter will just be highlighted with the choosen color

3. Marker color: choose a proposed color or create on from the color palette

4. ECU Id

5. Application Id

6. Context Id

7. Header Text: the string consist of all the message header data like Time, Timestamp, Ecuid ...
( regardless if displayed in the table view )

8. Payload Text

9. Log Level Min

10. Log Level Max

11. Control Messages

4.6.2 Sort by Time

If the �lters are enabled, even if there is no active �lter applied, you can select "Sorted by Time" in
the Filter tab of the Project Panel. In this case all messages will be sorted by received time.
E.g. in case you load several log�les which contain messages from di�erent ECUs you will get the
messages sorted by the recveive time, not by the message index.

CAUTION: Take care of the (target) Timestamp - it may happen that messages are
not received in the order like they are emitted by the speci�c application on the target
but like they are sent out by the target system

4.6.3 Using regular expressions

You can create more complex �lters by making use of the Qt regular expressions, e.g. using wildcards
and so on. To enable regular expressions select the checkboxes "regex" available for Ctid, Header
Text and Payload Text.

CAUTION: Regular expressions allow complex and conditional search criteria but can
slow down the �lter performance tremendously

4.6.4 Recommendations and examples

4.6.4.1 Filtering for multiple context IDs

For �ltering mutilple Ctids use one �lter with "TC|HADT|PRER|GNRL" as a regular expression in
"Context Id" instead of de�ning four seperate �lters.

4.6.4.2 Filtering for message payload containing multiple strings

E.g. in case you want to �lter out all lines where the payload contains the strings "getBatterieData"
or "message start" use:

(getBatterieData|message start)

as "Payload Text" and enable RegExp in the �lter con�guration

4.6.4.3 Filtering for certain loglevel only

If you only want to see messages between loglevels fatal and warn you should set Log Level Min to
warn and Log Level Max to fatal
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4.7 Project Files

You can save project speci�c settings like the status of plugins ( including used con�guration �les ),
active �lters, ECU autoconnet and so on for later reuse in a project �le. The project �le extension is
"*.dlp". The project �le rules the standard con�guration settings of con�g.ini. You also can specify a
project �le as default to be automatically loaded at viewer start, see ?? in ??.
Project�les can also be speci�ed in a command line call and are especially helpful here. Select Menu
"Project" to manage project �les. To save the current settings you also can press the "save project"
icon
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4.8 Command line mode

If you call the DLT Viewer on command line you get the following output:

4.8.1 Commandline help

dlt_viewer -h ( Linux ) or dlt_viewer.exe -h ( Windows )

Usage: dlt_viewer [OPTIONS]

Options:

-h Print usage

-p projectfile Loading project file on startup (must end with .dlp)

-l logfile Loading logfile on startup (must end with .dlt)

-f filterfile Loading filterfile on startup (must end with .dlf)

-s or --silent Enable silent mode without warning message boxes.

-v or --version Only show version and buildtime information

-c logfile textfile Convert logfile file to textfile (logfile must end with .dlt)

-u Conversion will be done in UTF8 instead of ASCII

-csv Conversion will be done in CSV format

-d Conversion will NOT be done, save in dlt file format again instead

-dd Conversion will NOT be done, save as decoded messages in dlt format

-e "plugin|command|param1|..|param<n>" Execute a plugin command with <n> parameters.

Examples:

dlt_viewer -c ./traces/trace.dlt ./trace.txt

dlt_viewer -s -c -u ./trace/trace.dlt ./trace.txt

dlt_viewer -s -d -c ./trace/trace.dlt ./trace.dlt

dlt_viewer -s -p ./proj/decodeded.dlp -dd -c ./trace/trace.dlt ./trace.dlt

dlt_viewer -s -csv -c ./trace/trace.dlt ./trace.csv

dlt_viewer -s -d -f ./filter/filter.dlf -c ./trace/trace.dlt ./filteredtrace.dlt

dlt_viewer -p ./proj/export.dlp -l ./trace/trace.dlt -e "Filetransfer Plugin|export|./ftransferdir"

4.8.2 Command line run

You can just start the viewer on command line to get more detailed output on console. As on
windows the console currently is closed when giving no parameter you have to use -s or -l as a
workaround. At the beginning you get information about DLT Viewer version, build date and plugin
status. Also you get some debug output on what the viewer actual is doing.
Example output:

C:\01-viewer\r690>dlt_viewer.exe -s

Enable silent mode

Start "dlt_viewer.exe"

Build time Jun 15 2018 09:24:40

Version 2.19.0 WORKING

**********************************************************

Loading plugin "DLT Viewer Plugin" "1.0.1"

Loading plugin "Filetransfer Plugin" "1.2.1"

Loading plugin "Lifecycle Plugin" "1.3.1"

Loading plugin "Non Verbose Mode Plugin" "1.0.0"

Activate plugin "DLT Viewer Plugin" 1.0.1

Try to connect to ECU "160.48.199.99" "12:55:43"

Reconnect timeout for "160.48.199.99"

...

4.8.3 Examples

Command line usage examples:

4.8.3.1 Extract �les from log�le using the �leransfer plugin

You can use the Filetransfer Plugin to extract �les out of a stored dlt �le e.g. in an automated test
setup. To do this, call the Viewer with this command and parameters:
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dlt_viewer.exe -p x.dlp -l y.dlt -e "Filetransfer Plugin|export|[path_to_extract]"

• dlt_viewer.exe:
The executable of the DLT Viewer. E.g. dlt_viewer.exe in Windows, dlt_viewer in Linux

• x.dlp:
A project settings �le which has the �letransfer properly con�gured, e.g. by setting a valid
plugin xml �le ( if needed )

• y.dlt:
Path to a dlt trace �le containing embedded �les which shall be extracted

• -e:
triggers the plugin internal command ( depending on plugin implementation )

• "Filetransfer Plugin":
Filetransfer Plugin will be called for the command interface

• export:
the plugin internal function "export" is addressed

• [path_to_extract]:
Path to the folder where you want to extract all �le dumps. If you apply this for a lot of �les,
think about using individual paths, to avoid overwriting �les with identical names.

4.8.3.2 Command line start of GUI with dedicated log�le

dlt_viewer -l ./example.dlt

4.8.3.3 Command line start of GUI with dedicated log�le and �lter�le

dlt_viewer -l ./example.dlt -f ./filter.dlf

4.8.3.4 Convert to ASCII �le

dlt_viewer -c ./example.dlt ./example.txt

4.8.3.5 Convert to UTF8 �le

dlt_viewer -u -c ./example.dlt ./example.txt

4.8.3.6 Convert to ASCII �le in silent mode

dlt_viewer -s -c ./example.dlt ./example.txt

4.8.3.7 Filter and convert to ASCII �le

dlt_viewer -f /viewertests/filterfiles/export.dlf -c ./example.dlt ./example.txt

4.8.3.8 Filter, decode and convert to ASCII �le

dlt_viewer -p /viewertests/filterfiles/example.dlp -c ./example.dlt ./example.txt

4.8.3.9 Filter and save as DLT �le

dlt_viewer -s -d -f /filterfiles/filter.dlf -c ./example.dlt ./example_filtered.dlt

4.8.3.10 Filter, decode and save as DLT �le

dlt_viewer -s -dd -f /project/example.dlp -c ./example.dlt ./example_decoded.dlt
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4.8.3.11 Decode and save as DLT �le

dlt_viewer -p ./export.dlp -l ./filetransfer.dlt -e "Filetransfer Plugin|export|./ft_dir"

4.8.4 Shell script examples of command line calls

You also can place dlt viewer command line calls to be used in shell scripts for use in automated
log�le processing, e.g. in a Jenkins environment and e.g. make use of Linux commands like grep, wc ,
awk, sed on converted dlt logs.
Example:

#!/bin/bash

for files in `ls *.dlt`

do

dlt_viewer -s -f ./dltfilters/Filter_v5.dlf -c $files ${files}_filtered.txt

done
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4.9 Send DLT injection

If implemented on the target you can send triggers and data to a speci�c context of an application.
So you can change variable values in a running application or just trigger any kind of functions. For
more details see the DLT Daemon documentation.
To open the injection dialog select the choosen Ctid the Control tab of the Project Panel and select
right mouse button "Send injection".
E.g. your application ID is "myid", context ID is "myct" you can send some data by opening the
injection dialog.

Figure 26: Injection dialog

1. Application ID

2. Context ID

3. Service ID - vaild service IDs start from 4096

4. Text Data / Binary Data - any data you want to be processed in your application

You can also evaluate the example implementation dlt-speed-app to see how the message injection
works.

4.9.1 DLT injection via command line

Allthough this subject is not part of the DLT Viewer I would like to emphasize that DLT injections
also can be issued by aid of the command line tool dlt-control coming with the dlt daemon. You can
use it e.g. in a test script. So the restriction is: it only is avaliable for Linux.
Example:

dlt-control localhost -a SPEE -c MISC -s 4097 -x "01 02 03"

Send injection message:

AppId: SPEE

ConId: MISC

ServiceId: 4097

Message: 01 02 03

Size: 3

4.9.2 Send injection from a plugin

In case you want to send an injection from within a plugin you can make use of the function

QDltControl:: sendInjection(int index,QString applicationId,QString contextId,int serviceId,QByteArray data)

It is part of the Controlplugin interface. You can �nd an example in the dlt-speed-plugin source code
also.
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5 Building the DLT Viewer

This is not a comprehensive instruction how to build the DLT Viewer and Parser. It just is an
example how the viewer can be build. On more information also see �le INSTALL.txt.

5.1 Windows

If you check out ( clone ) the DLT Viewer you �nd some *.bat �le which can be used to build the
Viewer on command line. Building also was veri�ed and performed using the QT Creator using Qt
5.5.1 + MSVC 2013, Qt5.6.1 + MSVC 2015,Qt5.8 + MSVC 2015 as well as Qt5.12.4 + MSVC 2017

5.1.1 Windows build example command line

5.1.1.1 Preconditions

Download and install:

qt-opensource-windows-x86-msvc2015_64-5.8.0.exe and

wdexpress_full_2015.exe

5.1.1.1.1 Viewer Windows build In the root folder of the viewer source you �nd some windows
bat �les. To build the viewer you have to set some parameters regarding your local installation.
Example:

set ARCHITECTURE=x86_amd64

set MSVC_DIR=C:\Program Files (x86)\Microsoft Visual Studio 14.0\VC

set QTDIR=c:\Qt\Qt5.8.0\5.8\msvc2015_64

set DLT_VIEWER_SDK_DIR=c:\DltViewer

.\build_sdk_windows_qt5_MSVC.bat

You �nd the artefacts in the folder

c:\DltViewer.

5.1.1.1.2 Parser Windows build

set ARCHITECTURE=x86_amd64

set MSVC_DIR=C:\Program Files (x86)\Microsoft Visual Studio 14.0\VC

set QTDIR=c:\Qt\Qt5.8.0\5.8\msvc2015_64

.\build_parser_windows_qt5_MSVC.bat

You �nd the artefacts in the folder c:
DltParser

5.2 Linux

The example was build on Ubuntu 16.04 with QT 5.5.1 and 18.04 with QT 5.9.5

5.2.1 Ubuntu 18.04 build example command line

5.2.1.1 Preconditions

Get these packages:

sudo apt-get install g++ qt5-default libqt5serialport5-dev
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5.2.1.2 Using cmake

sudo apt-get install cmake

In the root directory do:

mkdir build

cd build

cmake ..

make

or

make install

You �nd the dlt_viewer and the dlt_parser in subdirectory "bin" ...

5.2.1.3 Using qmake

In the Viewer root directory call

cmake

make

Find the resulting binaries in the subdirectory "release"

5.2.1.4 Using qmake building deb packages

This example additionally creates debian packages for you.

sudo apt-get install git devscripts debhelper

In the root directory call:

./build_viewer_debs.sh

Find the resulting debian packages in ./debtemp

For installation:

sudo apt-get install ./genivi-dlt-viewer
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6 Building the documentation

6.1 DLT Viewer user manual

The documentation was changed from asciidoc to LATEX, in September 2018.
and veri�ed on an Ubuntu 18.04 installation.

sudo apt-get install texlive texlive-latex-extra

To create a pdf format output use:

pdflatex dlt-viewer_user_manual.tex

6.2 DLT Viewer Plugins Programming Guide

On Linux call convert.sh in the doc folder to get a resulting pdf.

6.3 Doxygen documentation

On Linux:

Install doxygen and graphviz

Change into project directory

doxygen sdk/doxygen_dlt_viewer_plugininterface.cfg

(Optional) doxygen sdk/doxygen_dlt_viewer.cfg

(Optional) doxygen sdk/doxygen_dlt_viewer_qdlt.cfg

You will �nd the documentation in the subdirectory DLT-Viewer in the doc directory.
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7 Create DLT Viewer Plugins

In order to create new custom plugins it may be the fastest way to take one of the examples provided.
So here is an instruction how to add the example dlt-speed-plugin to the active build con�guration.
First copy the folder examples/dlt-speed-plugin to the folder plugins of the Viewer. This example
uses qwt and so you will have to take care that qwt ist available on your system.

7.1 Linux

Install QWT: sudo apt-get install libqwt-qt5-dev

7.1.1 qmake

Now add the plugin to plugins/plugin.pro

SUBDIRS += dlt-speed-plugin

Build the Viewer:

qmake BuildDltViewer.pro

make

You will �nd the Viewer in release/dlt_viewer and the plugin in release/plugins/libspeedplugin.so

7.1.2 cmake

Add this line to plugins/CMakeList.txt:

add_subdirectory(dlt-speed-plugin)

and build the Viewer:

mkdir -p build

cd build

cmake ..

make

You will �nd the Viewer in build/dlt-viewer and the plugin in build/plugins/libspeedplugin.so

7.2 Windows

7.2.1 Build qwt

For Windows download "qwt-6.1.3.zip", build and install it using the bat �le provided:
build_qwt_windows_qt5_MSVC.bat
Example:

set ARCHITECTURE=x86_amd64

set QTDIR=c:\Qt\Qt5.8.0\5.8\msvc2015_64

set MSVC_DIR=C:\Program Files (x86)\Microsoft Visual Studio 14.0\VC

set DLT_VIEWER_SDK_DIR=c:\DltViewerSDK

set QWT_DIR=C:\Qwt-6.1.3_2015_5.8_64bit

set QMAKEFEATURES=%QWT_DIR%\features

call .\build_qwt_windows_qt5_MSVC.bat

In this example QWT will be installed in

C:\Qwt-6.1.3_2015_5.8_64bit
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7.2.2 Build Viewer using qmake

Now add the plugin to plugins/plugin.pro

SUBDIRS += dlt-speed-plugin

and add these lines to: plugins/plugins.prj

CONFIG += qwt

# Directories

QWT_DIR = $$(QWT_DIR)

!isEmpty(QWT_DIR) {

QWT_INSTALL_PREFIX = $$QWT_DIR

} else {

QWT_INSTALL_PREFIX = C:\\Qwt-6.1.3

}

...

# Include path

win32:INCLUDEPATH += $$QWT_INSTALL_PREFIX\\include

...

### Additional Library path ###

win32:QMAKE_LIBDIR += $$QWT_INSTALL_PREFIX\\lib

You also have to remove the comment from the line

rem copy %BUILD_DIR%\plugins\speedplugin.dll %DLT_VIEWER_SDK_DIR%\plugins

in build_sdk_windows_qt5_MSVC.bat
Now call the build bat �le:

set ARCHITECTURE=x86_amd64

set MSVC_DIR=C:\Program Files (x86)\Microsoft Visual Studio 14.0\VC

set QTDIR=c:\Qt\Qt5.8.0\5.8\msvc2015_64

set DLT_VIEWER_SDK_DIR=c:\DltViewer

.\build_sdk_windows_qt5_MSVC.bat

Viewer build example ( installation paths may di�er ) :
The directory DLT_VIEWER_SDK_DIR will contain the Viewer binary as before, the additional
plugin can be found in the plugin subdirectory.

7.3 Demo application on Linux target

To see the functional basics of the plugin you will need a Linux target with a running DLT Daemon
and an application sending messages to the daemon. About how building and installing the DLT
Daemon please have a look at the DLT Daemon documentation. Once the daemon is installed,
building the demo application is quite easy.
E.g.

cd examples/ dlt-speed-app

cmake .

make

sudo ./dlt-speed-app

Now you just need to set up a connection to your target in the DLT Viewer and activate the speed
plugin.
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8 Known issues

Limitations:
maximum log �le size basically limited by the �le system, but it is recommended to use < 10 GB
performance is reduced Crashes at about 21 GB on a 64 bit Ubuntu machine with 64GB RAM.
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